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Important Information — Please Read Before Use

Intended Use

The DS-500 instrument has been designed to perform nondestructive measurements of 
industrial and commercial materials.

Do not use the DS-500 instrument for any purpose other than its intended use.

Instruction Manual

This instruction manual contains essential information on using this product safely and 
effectively. Before use, thoroughly review this instruction manual and use the product as 
instructed.

Keep this instruction manual in a safe, accessible location.

Instrument Compatibility

Using incompatible equipment can result in a malfunction and/or equipment damage.

Repair and Modification

The DS-500 instrument does not contain any user-serviceable parts. 
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Do not disassemble, modify, or attempt to repair the instrument to prevent human injury 
and/or equipment damage.

Safety Symbols

The following safety symbols may appear on the instrument and in the instruction manual:

 General warning symbol:

This symbol is used to alert the user to potential hazards. All safety messages that follow 
this symbol shall be obeyed to avoid possible harm.

 High voltage warning symbol:

This symbol is used to alert the user to potential electric shock hazards higher than 
1,000 volts. All safety messages that follow this symbol shall be obeyed to avoid possible 
harm.

Safety Signal Words

The following safety symbols may appear in the documentation of the instrument:

The DANGER signal word indicates an imminently hazardous situation. It calls attention to 
a procedure, practice, or the like, which, if not correctly performed or adhered to, could 
result in death or serious personal injury. Do not proceed beyond a DANGER signal word until 
the indicated conditions are fully understood and met.

The WARNING signal word indicates a potentially hazardous situation. It calls attention to a 
procedure, practice, or the like, which, if not correctly performed or adhered to, could result 
in death or serious personal injury. Do not proceed beyond a WARNING signal word until the 
indicated conditions are fully understood and met.

The CAUTION signal word indicates a potentially hazardous situation. It calls attention to 
an operating procedure, practice, or the like, which, if not correctly performed or adhered to, 
could result in minor or moderate personal injury, material damage, particularly to the 
product, destruction of part or all of the product, or loss of data. Do not proceed beyond a 
CAUTION signal word until the indicated conditions are fully understood and met.
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Notes Signal Words

The following safety symbols may appear in the documentation of the instrument:

The IMPORTANT signal word calls attention to a note that provides important information 
or information essential to the completion of a task.

The NOTE signal word calls attention to an operating procedure, practice, or the like that 
requires special attention. A note also denotes related, parenthetical information that is 
useful but not imperative.

The TIP signal word calls attention to a type of note that helps you apply the techniques and 
procedures described in the manual to your specific needs, or that provides hints on how to 
use effectively the capabilities of the product.

Safety

Before applying power, verify that the correct safety precautions have been taken (see the 
following warnings.) In addition, note the external markings on the instrument that are 
described under Safety Symbols. 

Warnings

General Warnings

• Carefully read the instructions contained in the user’s manual prior to powering on the 
instrument.

• Keep the user’s manual in a safe place for further reference.

• Follow the installation and operation procedures.

• It is imperative to respect the safety warnings on the instrument and in the user’s manual.

• If the equipment is used in a manner not specified by the manufacturer, the protection 
provided by the equipment could be impaired.

• Do not install substitute parts or perform any unauthorized modification to the 
instrument.

• Service instructions, when applicable, are for trained service personnel. To avoid a 
dangerous electric shock, do not perform any service unless qualified to do so.
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• Before powering on the instrument, you must connect the protective earth terminal of the 
instrument to the protective conductor of the (mains) power cord. The mains plug shall 
only be inserted in a socket outlet provided with a protective earth contact. Never negate 
the protective action by using an extension cord (power cable) without a protective 
conductor (grounding.)

• Only use fuses with the required rated current, voltage, and specified type (normal-blow, 
slow-blow, quick-acting, etc.). Do not use repaired fuses or short-circuited fuse holders. 
To do so could cause an electric shock or fire hazard.

• Whenever it is likely that the ground protection is impaired, you must power off the 
instrument and secure it against any unintended operation.

• The instrument must be connected only to a power source corresponding to the type 
indicated on the rating plate.

IElectrostatic Discharge Precautions

If, for any reason, you have to disassemble your instrument or touch any internal component, 
take all the necessary precautions against electrostatic discharges (ESD.) Electrostatic 
discharges may be responsible for damaging or even blowing electronic components in your 
system. Electrostatic damage to components can take the form of upset or even system 
failures. In addition, omitting to take appropriate precautions could void your limited 
warranty.

The basic rules of ESD control are:

1. Handle ESD-sensitive components only in protected work areas. Always ground yourself 
when handling ESD-sensitive components or assemblies. Be sure to use the proper 
maintenance and work procedures in conjunction with the type of material.

2. Always use a conductive or shielding container during storage or transportation of ESD-
sensitive components or assemblies (for ex.: printed circuit boards.) The materials used 
must create a Faraday cage, which will isolate the contents from electrostatic charges.

3. Open ESD-safe containers only at a static-safe workstation. Such a workstation shall 
include the equipment needed to perform the three critical functions: grounding, 
isolation, and neutralization.

At the static-safe workstation, follow these instructions before beginning any work:

• Put on your wrist strap or foot grounding devices.

• Test your grounding devices to ensure that they are functioning properly.

• Check all grounding cords to ensure that they are properly connected to the ground, 
ensuring the effective dissipation of electrostatic charges.

• If you have an ion generator, turn it on. This will help dissipate static charges from any 
nonconducting materials.

• Ensure that your work surface is clean and clear of unnecessary materials, particularly 
common plastics.

• When handling electronic devices, hold the components by their plastic edges. Avoid 
touching the metal leads.
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• When passing loaded boards or components between individuals, both individuals must 
be grounded to the same ground point or potential.

• Avoid bringing components in contact with your clothing, hair, or other nonconducting 
materials.

The previous procedures are only a summary of the measures to be taken against 
electrostatic discharges. Please consult the literature dedicated to this topic for more details.

WEEE Directive

In accordance with European Directive 2002/96/EC on Waste Electrical and Electronic 
Equipment (WEEE), this symbol indicates that the product must not be disposed of as 
unsorted municipal waste, but should be collected separately. 

Industrial inspection systems usually include equipment from other manufacturers. This is a 
summary of applicable items: 

• This directive applies to the above-mentioned equipment, as indicated by Annex 1A, 
item 9, “Monitoring and Control Instruments.” 

• The WEEE symbol has been placed on the DS-500, and units, in accordance with Article 
(10), “Information for Users,” and Annex IV, “Symbol for the Marking of Electrical and 
Electronic Equipment.”

• As suggested in Article (6), “Treatment,” and Article (7), “Recovery” of the directive, we 
encourage waste material collection and processing systems for their products after their 
working life is finished. 

• The various other electrical and electronic components which have not been 
manufactured by our company (such as: motors, motor encoders, PLC, relays, air-
conditioner, power supply, connectors, switches, personal computer, keyboard, monitor, 
uninterruptible power supply, electrical cabinet, cables, and sensors) but which form part 
of the Industrial Inspection System, have been procured from manufacturers who have 
individually evaluated and marked their products as CE certified. 

EMC Directive Compliance

This equipment generates and uses radio-frequency energy, and if not installed and used 
properly (that is, in strict accordance with the manufacturer’s instructions), may cause 
interference. The DS-500 has been tested and found to comply with the limits for an 
industrial device in accordance with the specifications of the EMC directive. However, it 
should not be used in a residential, commercial, or light industrial environment. 
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Warranty Information

Your product is guaranteed to be free from defects in materials and workmanship for a 
period and conditions specified in the terms and conditions.

The warranty only covers equipment that has been used in a proper manner as described in 
this instruction manual and has not been subjected to excessive abuse, attempted 
unauthorized repair, or modification.

Inspect materials thoroughly on reception for evidence of external or internal damage that 
might have occurred during shipment. Notify the carrier making the delivery immediately of 
any damage, since the carrier is normally liable for damage in shipment. Preserve packing 
materials, waybills, and other shipping documentation in order to establish a damage claim. 
After notifying the carrier, contact us for assistance with the damage claim and equipment 
replacement, if necessary.

This instruction manual attempts to teach the proper operation of your product. The 
information contained herein is intended solely as a teaching aid and shall not be used in any 
particular application without independent testing and/or verification by the operator or the 
supervisor. Such independent verification of procedures becomes more important as the 
criticality of the application increases. For this reason, we make no warranty, expressed or 
implied, that the techniques, examples, or procedures described herein are consistent with 
industry standards nor that they meet the requirements of any particular application.

We reserve the right to modify all products without incurring the responsibility for 
modifying previously manufactured products.

Technical Support

We are firmly committed to providing the highest level of customer service and product 
support. If you experience any difficulties when using our product, or if it fails to operate as 
described in the documentation, first consult the user’s manual, and then, if you are still in 
need of assistance, contact our After-Sales Service.
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Introduction

The DS-500 Density Measurement System is an instrument based on a technology involving 
ultrasounds. This system measures with very high precision the density of the polyethylene 
and is intended for experimentation and quality control in the Plastics Industry. The purpose 
of this manual is to provide all the information required to install and operate the DS-500. Its 
goal is to provide the operator with a functional understanding of the instrument in order to 
use it to the maximum of its capabilities.

The DS-500 is a precision instrument made of high quality components in order to provide 
many years of reliable operation.

Manual Organization

This manual contains instructions on use of the DS-500 Density Measurement System. It is 
organized to allow progressive understanding of the system’s different functions. Each 
section, however, is complete in itself. This manual is therefore a useful reference.

For more detailed information concerning the temperature-controlled bath, please refer to 
the Haake Circulators Instruction Manual.

The manual begins with the theory of operation, that is, a description of the features and 
principle of the DS-500.

The following two chapters explains how to install the system, interconnect the units, and 
turn on the DS-500 in order to make it start up and work properly. The preparation of 
samples is also explained.

Chapter 4 discusses the operation of the instrument and show how to use the software and 
its commands.

Following chapters explaining the maintenance of the system and file structures, the last 
chapter of the manual presents a list of the technical specifications of the DS-500.

Conventions

In a procedure containing several steps, the operations that the user has to execute are 
numbered 1, 2, 3... The symbol “¨” is used to indicate a procedure containing only one step, 
or secondary steps.



DUMG029, Rev. D, April 2016

8    Introduction

SMALL CAPITALS are used to identify any term found as is on the instrument, such as the 
connector names and buttons.

The abbreviation “N/A” is used to indicate either not applicable or not available at time of 
press.

Furthermore, all the terms that are used by the software, such as the names of the dialog 
boxes, commands, text boxes, and functions, are presented in bold print.

The screen illustrations found in this manual were prepared with the software version 
available at time of press; they may slightly differ from what you see on the screen according 
to the current software version you are using. Furthermore, the screen illustrations are 
printed using the default setting in the Control Panel display parameters; their look may be 
different if you use another setting.
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1. Theory of Operation

This chapter presents the theory of operation of the DS-500 Density Measurement System. 
Sections presented below are the following:

• Features of the DS-500

• Ease of Operation

• Statistical Process Control (S.P.C.)

• DS-500 Principle

The density measurement system DS-500 provides an accurate, reliable, rapid and easy 
method of measuring the density in polyethylene. This technique has been shown to be 
applicable to all industrial polyethylenes: LDPE, MDPE, HDPE, as well as LLDPE and 
UHMWPE. This scientifically established method is based on the analysis of the ultrasonic 
propagation characteristics of the polymeric material.

1.1 Features of the DS-500

The results of density measurements obtained with the DS-500 correlate to those of the usual 
method (density gradient column) with an exceptionally high degree of accuracy: the 
statistical coefficient of correlation (R-squared) between the two methods is 0.9999. In 
addition, the DS-500 Density Measurement System offers a number of important advantages 
over the usual method:

1. The measurement is rapid: 15 seconds from beginning to end.

2. Standard (ASTM) press molded plaques are used as samples.

3. The samples need no further conditioning, which constitutes both added time savings 
and an increase in reliability.

4. The DS-500 method requires no complex operations such as are involved in the 
preparation of a density gradient column.

5. The measurement automatically compensates environmental changes of temperature.

6. The method is nondestructive, meaning that the sample can be kept in files for further 
reference or for a repetition of the measurement.

7. The DS-500 makes use of the most advanced electronic techniques and components. 
Being fully computerized and user-friendly, it requires no special skills from the operator.

8. A routine is included in the system which makes the DS-500 virtually foolproof.
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1.2 Ease of Operation

The DS-500 is user-friendly and designed for ease of operation. Upon initialization, the 
system is ready for testing. The sample is inserted in the cell and the density (with an 
accuracy of ±5 to the fourth decimal place) appears on the screen in less than 15 seconds.

The DS-500 requires minimal operator interface and interpretation. The entire process of 
density determination is automatically evaluated by the system. The DS-500 overcomes all 
major drawbacks of conventional density measurement methods. The entire setup process 
can be learned quickly.

1.3 Statistical Process Control (S.P.C.)

All accumulated data can be saved on the hard disk and transferred to a removable media 
such as floppy disks, CD-ROM disks, etc. Within a few seconds, the system gives access to 
either specific data or to a whole range of measurements that were previously made over a 
given period of time. The hard disk drive is designed to hold several years of tests results. 
The information can be processed under many forms and graphic representations.

1.4 DS-500 Principle

The most commonly used and accepted method for the density determination of 

polyethylene has been the use of a density-gradient column defined by the ASTM D-1505 
Standard. A small piece of the sample is placed in a column of liquid that exhibits a known 
density gradient; after it has sunk to its equilibrium level, the density is obtained by reading 
its position in the column.

The acoustic method used in the DS-500 for the determination of density is more than the 
result of a simple ad hoc correlation. The method finds its theoretical basis in the nature of 
the material (PE) itself. Polyethylene can be viewed as a composite where high density 
crystalline regions are embedded in a low density amorphous matrix. The degree of 
crystallinity determines the final density of the material.

The amorphous and crystalline phases show very distinct behaviors to the propagation of 
ultrasound. From this, it can be understood that the propagation characteristics in the 
composite will actually depend on the relative amount of the different phases, that is on the 
degree of crystallinity. Therefore, it can be said that the DS-500 provides a measurement of 
crystallinity which in turn is directly correlated to density.
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2. Installation of the DS-500

This chapter details the installation of the DS-500 Density Measurement System. Sections 
presented below are the following:

• Unpacking the DS-500

• Preparing the Temperature-Controlled Bath

• Interconnecting the Units

• Preparing the Samples

2.1 Unpacking the DS-500

The DS-500 system is usually shipped from the factory in two (2) boxes. Unpack carefully 
each box, compare each item with the list shown below and inspect visually for damage. If 
any evidence of damage is found, notify immediately the shipping company. Retain the 
shipping containers and padding material for future use.

The DS-500 consists of two (2) main units:

• Main system unit (computer) with keyboard, and mouse

• Measuring cell in a temperature-controlled bath

A standard color video monitor is required but not provided. The video monitor can be 
connected to one of the following video ports on the computer: HDMI, DVI-D, or DVI-I.

The following accessories are also included with the system:

• One compact disk labeled “DS-500 Setup and Manuals”

• One compact disk for the computer operating system

• One compact disk containing drivers for the computer peripherals

• One DS-500 User’s Manual

• One instruction manual for the circulator and temperature-controlled bath

• Power cables
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2.2 Preparing the Temperature-Controlled Bath

To prepare the temperature-controlled bath

Due to the high concentration of lime, hard water is not suitable for temperature control 
because it leads to calcification in the bath.
Ferrous water can cause corrosion, even on stainless steel.
Chloric water can cause pitting corrosion.
Distilled and deionized water can cause corrosion, even on stainless steel.

1. Fill the bath with approximately 15 liters of soft/decalcified water.

2. If available, add 33 milliliters of a wetting agent such as Echowet® to the bath water.

3. If available, add 12 milliliters of an algaecide such as Echocide® to the bath water.

4. Install the stainless steel plate carrying the measuring cell over the opening of the bath.

The water level should be approximately 1 cm (0.5 in.) below the stainless steel plate. When 
the transducer in the measuring cell is not fully immersed due to a low water level, 
measurements might become erratic or the plaque inserted in the cell might not be properly 
detected.
Soft/decalcified water must be added regularly to compensate for evaporation.

After adding solution or refilling the bath, it is necessary to let it settle for one hour before 
starting density measurements.

Adding any other liquid or additive in excess to the quantity prescribed could damage the 
measuring cell.

2.3 Interconnecting the Units

The following units must be interconnected:

• the keyboard

• the mouse

• the video color monitor

• the main system unit

• the measuring cell

• the temperature-controlled bath
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Units connect as follows:

1. The wireless keyboard and mouse are detected by a special adapter connected in one of 
the Universal Serial Bus (USB) ports at the back of the main system unit (computer).

2. The video color monitor, provided by the end user, connects to the main system unit 
using one of the following video ports: HDMI, DVI-D, or DVI-I.

3. Plug the video monitor and main system unit power cords into power outlets, using the 
power cords provided.

4. The control cable connects the measuring cell to the nine-pin connector located at the 
back of the main system unit.

5. The transducer cable of the cell plugs into the connector located at the back of the main 
system unit. The connector is a one-pin BNC-type connector.

6. The circulator power cable plugs into the outlet at the back of the bath.

7. The bath power cable connects into a power outlet.

Other standard computer peripherals can be connected to the other ports available on the 
main system unit: the 9-pin serial ports or USB ports.

2.4 Preparing the Samples

As with any piece of laboratory equipment, care must be taken in the preparation of test 
specimens. Specification ASTM D 1928 very clearly defines the proper method of preparing 
polyethylene (PE) compression molded plaques. We strongly suggests this procedure be 
strictly adhered to when preparing specimens for use with the DS-500.

The same care and conditions must be present for both calibration and density measurement. 
In other words, to achieve maximum accuracy, the DS-500 must be calibrated under the same 
conditions in which actual testing will occur.

The following general information will help the operator achieve optimum accuracy with the 
DS-500:

1. Acceptable size of plaques:

• Length: between 90 mm and 100 mm (3.54 in. – 3.94 in.)

• Width: between 35 mm and 38 mm (1.38 in. – 1.49 in.)

• Thickness: between 1.2 mm and 3 mm (0.05 in. – 0.12 in.)

Plaques of the highest thickness possible, without exceeding the maximum value of 3 mm, 
will yield the best results, as discrimination between ultrasonic echoes is enhanced.

2. All plaques must be totally homogeneous. They must show no indication of bubbles, 
folds, ripples, contaminants, inclusions, inconsistencies, variation in thickness or 
incomplete pellet melting.
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3. Surface condition is very important. The plaque must be as smooth as possible and of 
consistent thickness. Any pits or other surface inconsistencies that reside in the focus of the 
sound pulse may cause inaccuracies. The plaque does not have to be perfect but, plaque 
quality is very closely related to test accuracy. This is particularly true when looking for 
accuracy to the fourth decimal place.
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3. Turning On the DS-500

This chapter explains how to turn on the DS-500. Sections presented below are the following:

• Starting Up the System

• Operating the DS-500

3.1 Starting Up the System

The DS-500 is equipped with an internal hard disk on which all the necessary software has 
already been installed. A CD of the software labeled “DS-500 Setup and Manuals” is provided 
in case of loss of data or damage to the hard disk. Compact disks containing the operating 
system (OS) and the computer device drivers are also provided in case their reinstallation is 
required.

Store the compact disks in a safe place for future use.

To load the operating software of the DS-500, the operator only has to set the system power 
switch on. The operating software will be loaded automatically by the system unit (the 
computer).

Access to the hard disk, reading and writing, is indicated to the operator by a small blinking 
light located on the front panel of the main system unit.

Only the hard disk is used in the normal operating mode of the DS-500. Any access to the 
other disk drives is indicated by an in-use light located on the front of the disk drives. Do not 
open the drive when the in-use light is on; your data might be damaged in the process.

3.2 Operating the DS-500

To operate the DS-500

1. The main system unit is turned on by switches located on the front and on the back 
panels of the main system unit. First put the back-panel switch to the position marked by 
an “I”, and then, push upward the momentary switch labeled “PUSH ON/PUSH OFF”, 
located behind the front-panel door.
After approximately 5 seconds, the computer runs a self-test and loads its operating 
system.



DUMG029, Rev. D, April 2016

16    Chapter 3

2. The video monitor ON/OFF switch is located at the bottom of the screen of the monitor and 
the ON position is indicated by a lit indicator. 

3. The tilt of the keyboard can be adjusted for your typing comfort.

4. Turn the bath main switch on.

5. Turn the circulator main switch on, the controller performs a self-test, and them the 
software version is displayed (example: 11.0).

6. Press and hold the OK key ( ) for about 4 seconds, and then the actual bath 

temperature is indicated.

7. Wait until the temperature reaches 23 °C before taking density measurements. This 
temperature is preset at the factory.

If necessary, to adjust the preset temperature on the controller at 23 °C, press and hold the 

proper edit keys ( ) until the proper temperature reading is reached.

Never run the temperature-controlled bath without water or not enough water to activate the 
circulator, as the water in the bath might freeze. Permanent damage to the cell might occur.
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4. Operation of the DS-500

This chapter describes the operation of the DS-500. Sections presented below are the 
following:

• Initialization

• DS-500 main window

• Density Acquisitions

• Measurement Data Storage

• Retrieving Measurement Data

• Printing Data Measurements

• Calibration Files

• Creating a New Calibration File

• Modifying an Existing Calibration File

• Using a Different Calibration File

• Printing a Calibration File

• Turning Off the DS-500

4.1 Initialization

When the DS-500 system is turned on, the Microsoft® Windows® operating system is loaded 
and the DS-500 software program is started automatically. If the DS-500 software has been 
interrupted and closed, it can be restarted without rebooting the PC by double-clicking the 
DS-500 software icon (see Figure 4-1 on page 17).

Figure 4-1  The DS-500 software icon

After following the splash screen (see Figure 4-2 on page 18 ) that indicates the software 
version used, a 5-minute warm-up countdown is activated, providing a delay for the 
stabilization of the various electronic components. You can bypass this countdown by 

clicking  (see Figure 4-3 on page 18).
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Figure 4-2  The DS-500 splash screen

Figure 4-3  The warm-up countdown dialog box

4.2 DS-500 Main window

After this initial countdown, the system switches automatically to the Density Measurement 
mode (see Figure 4-4 on page 19) and the STD default calibration file is loaded.

The DS-500 main window is splitted in two (2) panels. The left panel labeled Measure 
contains the following sections:

Current sample

This field displays the name of the last sample computed by the software and its 
measurement in grams per cubic centimeters is displayed underneath the sample name. 
When no measurement has been acquired, the field name is empty and the measurement 
displays 0.0000.

File

This field displays the calibration file currently loaded. The default calibration file is 

STD. A different calibration file can be loaded by clicking  and selecting a different 

file (see section 4.10 on page 30).
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Sample Name

This section is used to change the name of the sample to a more meaningful name for the 
operator. By default, the sample name Prefix is Sample and the Auto Increment Suffix 
box is checked. Therefore, the first measurement is named Sample00000 and the 
following measurements are labeled Sample00001, Sample00002, Sample00003, etc.
To change the sample name Prefix, uncheck the Auto Increment Suffix box, insert a new 
sample in the measurement cell, enter a meaningful Prefix in the Measurement dialog 
box, and take a measurement. To reactivate the Auto Increment Suffix for the new 
Prefix, check its corresponding box.

Temp

This field monitors the temperature of the water, in degrees Celsius, in the temperature-
controlled bath. The temperature sensor located inside the measurement cell is used to 
compensate for temperature variations.

Figure 4-4  The DS-500 main window

The right panel labeled Report of the DS-500 main window contains the following sections:

File

This field is used to display the current file name where measurements are stored, when 
the operator decides to save the data. When no data file is loaded or no data has been 
stored, the field is empty.

Sample

This field displays a scrolling list of the previous Density measurements, along with their 
respective Date, Time, and Calibration file used. New measurements are appended at 
the bottom of the list.
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Current density measurements are stored in a temporary file on the computer hard disk, but 
can later be stored on a disk drive, in a new file, or appended to an existing file. 

To store density measurements in a new file

Click New on the File menu to clear the Report panel. When containing previous 
measurement data, the operator is first offered to save its content.

To append to an existing file

Click Open on the File menu, and the Open dialog box appears showing the list of files 
stored in the default directory. Click on the file name that you wish to append, and then click 
Open to load the data contained in the file in the DS-500 software application. The next 
density measurements will be appended at the bottom of that file.

4.3 Density Acquisitions

At this point, you can insert in the measuring cell a sample which will be automatically 
detected by the system. After inserting a sample, you are requested to accept the proposed 
identification name or number for the inserted sample, or to specify a different name or 
number (see Figure 4-5 on page 20).

Figure 4-5  The Sample name dialog box

The sample names can be generated automatically by the computer (see section 4.2 on 
page 18). A maximum number of 14 characters can be entered.

When  is clicked, the system then starts the first portion of the process. While the 

following message is displayed, do not move the sample inserted in the measuring cell.

Then a 20-second countdown appears on the screen (see Figure 4-6 on page 21).
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Figure 4-6  The Measurement: 20-second countdown dialog box

When the sample is not removed before the end of the 20-second countdown, the 
measurement is canceled. When the sample is removed, as requested, the second portion of 
the process starts and a reference acquisition is taken. Once the density has been computed, 
the density measurement is displayed in the Measure window and a new line is added in the 
Report data panel (see Figure 4-7 on page 21).

Figure 4-7  Density measurements in the Measure window

When a power failure occurs or the system is turned off without quitting the DS-500 program 
first, when the DS-500 is turned back on, the message box shown in Figure 4-8 on page 22 
appears.
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Figure 4-8  Message box for unsaved data

When you click , unsaved measurements can be stored following the procedure 
described in the section 4.4 on page 22. When you click , the information temporarily 
stored on the hard disk is deleted.

4.4 Measurement Data Storage

The measurements can be saved to the disk drive by clicking Save As on the File menu. The 
system then asks the operator to enter the file name under which the results will be stored 
(see Figure 4-9 on page 22). All measurement files are saved under a file name with the 
extension “.PRN”.

Figure 4-9  The Save Measurement File As dialog box

4.5 Retrieving Measurement Data

To retrieve previously stored measurement data files from the disk drives, click Open on the 
File menu. A standard Open dialog box appears on the screen (see Figure 4-10 on page 23) 
showing all the files present on the disk.
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Figure 4-10  The Open dialog box

Click on the desired file name to select it, and then click  to retrieve that file. The 

contents of the file is then displayed in the Report data panel.

4.6 Printing Data Measurements

To print measurements, click Print on the File menu. The Print Measurement dialog box 
appears (see Figure 4-11 on page 23).

Figure 4-11  The Print Measurement dialog box

By clicking the appropriate option button, you can then select to print All pages, the 
Last page only, or a range of pages specified in the From and To boxes. To configure the 

printer, if required, click the . The  button can be used to view on the 

screen the information to be printed. Clicking  will send the information to the 

printer.
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4.7 Calibration Files

Calibration files carry a file name with the extension “.COE”. A calibration file called 

STD.COE is provided by the factory as a default calibration file. At the time of initialization 
of the system, the DS-500 loads that calibration file STD.COE automatically. You can modify 
or replace this STD file after creating a custom calibration file. This new STD file will be 
loaded automatically by the system after initialization.

When this default calibration file is missing from the DS-500 directory or when the working 
directory is invalid, the message shown in Figure 4-12 on page 24 will appear on the screen:

Figure 4-12  Message for missing STD.COE calibration file

When the above message appears, copy the calibration file STD.COE to the DS-500 working 
directory.

4.8 Creating a New Calibration File

The method used here is based on the fact that the DS-500 system will accept samples as 
reference standards.

Research has indicated that PE compression molded plaques show definite effects of aging in 
the time following pressing. Normally, this property manifests itself in the form of increasing 
density which tapers off after several days. With this in mind, it is imperative that plaques 
used to build calibration curves be of similar age to plaques used for testing purposes.

The calibration can be performed with two or more reference samples. However, it is 
recommended to use at least ten (10) reference samples to obtain an accurate calibration.

A maximum number of 50 samples can be entered for a calibration.

You can calibrate the system based on another set of samples.

New calibration files can be created for different reasons:

1. In order to measure density in samples containing additives (different calibration files for 
samples containing different additives or quantities of additives).
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2. In order to measure density in other types of polymers. However, accurate measurements 
on polymers other than polyethylene are not guaranteed when using the DS-500.

It should be noted that the determination of the density of this system is based on the 
crystallinity of the material to be tested. For the other polymers, their density may not 
directly correlate with their crystallinity.

To begin a new calibration, click Calibration on the Window menu. The Calibration window 
appears (see Figure 4-13 on page 25).

Figure 4-13  The Calibration window

At this point, when a sample is inserted in the measuring cell, the Calibration Density dialog 
box appears (see Figure 4-14 on page 25).

Figure 4-14  The Calibration Density dialog box
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You must enter a name in the field Sample name (up to 15 characters), click in the 
Known density box, and then enter the known density of the sample, using the format 
“0.9999” or “.9999”.

The density range accepted by the DS-500 is limited by the software. If a density outside that 
range is specified, a message displaying the acceptable density range will be shown on the 
screen (see Figure 4-15 on page 26).

Figure 4-15  The acceptable density range

The system then starts the first portion of the calibration process. While the following 
message is displayed, do not move the sample inserted the measuring cell.

A dialog box displaying a 20-second countdown appears on the screen (see Figure 4-16 on 
page 26).

Figure 4-16  The Calibration: 20-second countdown dialog box
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When the sample is not removed before the end of the 20-second countdown, the 
measurement is canceled. When the sample is removed, as requested, the second portion of 
the process starts and a reference acquisition is taken. Once the velocity has been computed, 
the result is added to the graph.

A second sample must be inserted in order to calculate the calibration curve.

After a certain number of samples has been inserted and corresponding velocities have been 
calculated, a graph similar to Figure 4-17 on page 27 is shown on the Calibration window.

Figure 4-17  Graph on the Calibration window

Each circle in the graph represents an active sample. The current sample is green and the 

different samples can be selected one at the time by clicking  and .

Samples can be deleted or restored for calculation purposes by clicking  and .

Once a sample has been deleted for calculation purposes, the sample is no longer represented 
by a circle, but by a square.

You can zoom in and and zoom out the calibration graph using the  and  buttons of 
the Zoom section of the Calibration window.

The Statistics window (see Figure 4-18 on page 28) can be displayed by clicking Statistics on 
the File menu.

The Statistics window shows Linear Regression coefficients. To obtain maximum accuracy 
with the DS-500, it is imperative that the calibration curve be built with samples that fall ON 
the calibration line. It is quite possible to build a curve with a coefficient of correlation (R2) 
value of 0.9998 to 0.9999, when quality plaques are used.
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Figure 4-18  The Statistics window

The Status column is represented by ON, when the sample is enabled or restored, and by 
OFF when the sample has been delected and is not used for calculation purposes.

If points do not fall on the line (curve), the plaques may not be homogeneous or the known 
density may be incorrect.

Once you are satisfied with the new calibration file, click Save As on the File menu. The 
dialog box shown in Figure 4-19 on page 28 appears.

Samples deleted during the calibration process are lost and cannot be restored after saving 
the calibration file.

Figure 4-19  The Calibration: Save as dialog box



DUMG029, Rev. D, April 2016

Operation of the DS-500    29

Enter the new calibration file name (up to eight characters) under which the file will be 

stored, and then click . The Calibration Password dialog box is displayed in 

Figure 4-20 on page 29.

Figure 4-20  The Calibration: Password dialog box

Calibration file passwords are required to modify calibration files. Passwords should be 
stored in a safe location for future use.

As the calibration files are password-protected, you must enter a password, and then click 

.

4.9 Modifying an Existing Calibration File

To modify an existing calibration curve, in the Calibration window, select File, and then click 
Open. The Open dialog box will appear (see Figure 4-21 on page 29), showing the existing 
calibration files in the DS-500 working directory.

Figure 4-21  The Open (calibration files) dialog box



DUMG029, Rev. D, April 2016

30    Chapter 4

You must select the file to be modified and click . The selected file will be retrieved.

You are then required to enter the password for that specific file (see Figure 4-22 on page 30).

Figure 4-22  The Calibration: Password dialog box

If the password is incorrect, the message shown in Figure 4-23 on page 30 will appear.

Figure 4-23  Message for an incorrect password

If the password is accepted by the system, at this point, additional samples can be inserted in 
the measuring cell to modify the calibration file.

The rest of the procedure is already described in section 4.8 on page 24.

A different password can be specified at the end of the process. This new password should 
be noted and stored in a safe location for future use.

To exit the Calibration mode, select Measurement & Report on the Window menu.

4.10 Using a Different Calibration File

To select a calibration file other than the STD.COE file, click  in the Measure panel of 

the main DS-500 window. The Open dialog box shown in Figure 4-24 on page 31 will appear. 

You can then click on the desired calibration file, and then click .
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Figure 4-24  The Open (calibration files) dialog box

4.11 Printing a Calibration File

To print the current calibration file, you can click Print on the File menu. The Print 
Calibration dialog box will appear (see Figure 4-25 on page 31).

Figure 4-25  The Print Calibration dialog box

By clicking the appropriate option button, you can then select to print only the 
Calibration Curve, or to print only the Statistics, or to print Both. To configure the printer, if 

required, click the .  can be used to view on the screen the information to 

be printed. Clicking  will send the information to the printer.

4.12 Turning Off the DS-500

To exit the DS-500 software, select Quit on the File menu.

When the previous measurements have not been saved, Figure 4-26 on page 32 is displayed. 
Please refer to section 4.4 on page 22 for the procedure for saving the data.
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Figure 4-26  The Report: Measurement data saved

To shut down your computer, click  in the computer taskbar, click , 

and then click  (see Figure 4-27 on page 32).

Figure 4-27  Turning off computer

When shutting down the computer without first exiting the DS-500 software, when the DS-
500 software is run again, Figure 4-28 on page 32 is displayed to enable the operator to save 
the measurement data from the previous session.

Figure 4-28  Warning: saving previous data

If you wish to save the data from the previous session, please refer to the procedure in 
section 4.4 on page 22.
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5. Operating and File Systems

This chapter describes the DS-500 file nomenclature.

The DS-500 system uses very popular Microsoft® operating systems. Therefore, the operator 
can handle and manage files created by the DS-500 with popular spreadsheet and database 
software applications.

5.1 7.1 Hard Disk Structure

The hard disk is configured with a root directory and several subdirectories.

The root directory contains files such as system configuration files required by the operating 
system.

The subdirectory “C:\Program Files\DS500\” contains the following DS-500 files:

• DS500.EXE: main DS-500 program application

• DS500.INI: initialization file for the Microsoft® Windows® operating system

• STD.COE: default calibration file

All above files must be present in the working directory of the DS-500.

5.2 Calibration files

Files with the file name extension “.COE” are calibration files and are usually stored in the 
subdirectory “\Program Files\DS500”. These files can be opened with the application 
Microsoft® Notepad or imported in the Microsoft® Office® Excel application.

The linear regression equation used is in the following format:

Y = mX + b

where:

• Y is the velocity measured in centimeters per second

• m is the slope is the calibration curve

• X is the density computed

• b is the offset of the calibration curve
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An example of a calibration file is shown in Figure 5-2 on page 34.

Figure 5-1  Example of calibration file

The first number represents the slope (m) of the calibration curve, the second number 
represents the offset (b), followed by the date and time of creation of the calibration file. 
Sample names are also provided along with their known densities and measured ultrasound 
velocities in centimeters per second.

5.3 Measurement Data Files

Files with the file name extension “.PRN” are measurement data files and are usually stored 
in the subdirectory “\My documents”. They can be opened with Microsoft® Notepad 
application or imported in the Microsoft® Office® Excel application.

An example of a data file is shown in Figure 5-2 on page 34.

Figure 5-2  Example of data file

The sample name is displayed in the first column, the velocity measured in centimeters per 
second is displayed in the second column, the density computed is displayed in the third 
column, the two following columns display the data and time of measurements and the last 
column displays the nam of the calibration file used.
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6. Maintenance

This chapter discusses the maintenance of the DS-500. Sections presented below cover the 
following topics:

• Maintenance of the Measuring Cell and Bath

• Maintenance of the Main System Unit

6.1 Maintenance of the Measuring Cell and Bath

The purpose of this procedure is to clean the cell and remove the waste accumulated during 
its use.

The bath should be drained every two (2) weeks to avoid dirt accumulation inside. The 
following procedure must be carried out.

To drain the bath

1. Make sure that the DS-500 and the bath are turned off.

2. Disconnect all cell and bath cables.

3. Remove the drain plug on the bath and drain the liquid.

4. Put the plug back in.

5. Wipe the interior of the bath and the cell with a soft cloth.

6. Fill the bath according to the installation procedure.

DO NOT USE DETERGENT OR ANY OTHER SOLUTION. These solutions could damage 
the cell.

After adding solution or refilling the bath, it is necessary to let it settle for one hour before 
starting density measurements.

6.2 Maintenance of the Main System Unit

There is an air filter located on the front panel of the main system unit.
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To check or replace the filter

1. Make sure the system unit power is set to off.

2. Loosen the four (4) screws securing the filter cover at the front of the main system unit.

3. Check the filter. If necessary, replace it with a new one.

4. Reinstall the filter and cover.
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7. Specifications

This chapter covers the specifications concerning the DS-500 density measurement system. 
Sections presented below cover the following topics:

• Range of Operation

• Main System Unit

• Video Monitor

• Bath and Circulator

7.1 Range of Operation

7.2 Main System Unit

Table 1  Operating specifications 

Category Description

Density range 0.9100–0.9700 g/cc

Warm-up time 5 minutes

Cell life 10,000 hours

Plaque size Heigth: 90 mm – 100 mm (3.54 in. – 3.94 in.)

Width: 35 mm – 38 mm (1.38 in. – 1.49 in.)

Thickness: 1.2 mm – 3 mm (0.05 in. – 0.12 in.)

Operating temperature 23 °C (73 °F)

Table 2  Main unit general specifications 

Category Specification Value

Housing Size 432 mm × 177 mm × 445 mm
(17 in. × 7 in. × 17.5 in.)

Weight 11.4 kg (25 lb)

Power requirements Voltage 90 VAC to 265 VAC, 50/60 Hz, 750 watts

Environmental conditions Operating temperature 0 °C to 45 °C (32 °F to 113 °F)

Storage temperature –25 °C to 65 °C (–13 °F to 149 °F)

Relative humidity Operating: 85 % noncondensing

Non-operating: 95 % noncondensing
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7.3 Video Monitor

Processor Type Intel Pentium IV, 2 GHz dual core

Cache 1MB L2 cache

Memory Type 1 GB dual-channel DDR2 SDRAM

Operating System Type Microsoft Windows XP Professional

Data storage Storage devices 80 GB 7200 RPM SATA Hard disk
1.44 MB Floppy disk
CD-R/W-DVD-R/W disk drive

I/O ports USB ports 5 USB 2.0 compliant ports: 1 on front panel, 
4 on back panel

Ethernet One LAN 10/100 Mb/s (megabits/second)
One PCI Express Gigabit LAN

Video output Video out (SVGA)

Additional ports Parallel, serial, PS/2 keyboard, PS/2 mouse, 
audio

Input devices Type Microsoft 104-key keyboard
Microsoft optical mouse

Safety European directives and 
standards

The “CE” marking indicates conformity 
with all applicable directives and standards 
of the European community, that is, 
Electrical equipment for measurement, control 
and laboratory use - EMC requirements - Part 
1: General requirements (IEC 61326-1).

Table 3  Specifications for video monitor 

Category Specification

Panel size 20_in diagonal

Type LCD, TFT active matrix

Resolution 1600 x 900 pixels

Number of colors 16.7 million

Power requirements 100 VAC to 240 VAC, 50/60 Hz

Size 525 cm x 109 mm x 393 mm
(20.67 in. x 4.29 in. x 15.47 in.)

Weight 4.297 kg (9.45 lb)

Table 2  Main unit general specifications (continued)

Category Specification Value
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7.4 Bath and Circulator

Table 4  Specifications for bath and circulator 

Category Specification

Voltage 115 VAC/230 VAC, 50/60 Hz
Tolerance: +/-10 %

Consumption 1500 VA at 115VAC
2550 VA at 230 VAC

Size 340 mm x 540 mm x 400 mm

Volume 15 liters maximum
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